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What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources 
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey
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	 7	 Organize Your Inbox
In this chapter, you will learn how to

✔	 Work with Conversation view.
✔	 Arrange messages in different ways.
✔	 Organize Outlook items by using color categories.
✔	 Organize messages in folders.
✔	 Manage messages by using Quick Steps. 
✔	 Quickly locate messages.
✔	 Print messages.
✔	 Delete messages.

You can use Microsoft Outlook 2010 to manage multiple e-mail accounts, including 
multiple Microsoft Exchange Server accounts with their associated contacts, calendars, 
and so on. Even if you use Outlook only for sending and receiving e-mail messages, 
you can rapidly build up a mass of messages that make it difficult to locate information. 
Fortunately, Outlook is designed to act as a complete information-management system; 
it provides many simple yet useful features that enable you to organize messages and 
other Outlook items and to quickly find information that you need.

Outlook 2010 automatically handles certain types of organization for you. In your 
Inbox, Outlook makes it easy to follow related messages (message threads) from mul-
tiple people by displaying the messages in Conversation view. Outlook Search almost 
instantly locates items that contain specific content, and it allows you to save search 
results as Search Folders in which you can view up-to-date search results at any time.

You can organize items in Outlook by storing related items in folders and by assigning 
color categories to related items.

In this chapter, you’ll work with Conversation view to locate different levels of messages in 
a series. You’ll display the messages in your Inbox in a variety of arrangements and organize 
messages by assigning color categories and by moving them to folders within your Inbox. 
You’ll filter and find messages by using the Search feature, and use Search Folders. You’ll 
work with the built-in Quick Steps. Finally, you’ll preview, print, and delete messages.
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Practice Files  The exercises in this chapter use Outlook items you created in exercises in 
previous chapters. If an exercise requires an item that you don’t have, you can complete 
the exercise in which you create the item before beginning the exercise, or you can 
substitute a similar item of your own. A complete list of practice files is provided in 
“Using the Practice Files” at the beginning of this book.

Working with Conversation View
Conversation view is an arrangement of messages grouped by subject. All the messages 
with the same subject appear together in your Inbox (or other message list) under one 
conversation header. 

Message senders

Collapsed conversation headers

Unread messages

Until you expand the conversation header, the entire conversation takes up only as much space in 
your Inbox as a single message would. 

The conversation header provides information about the messages within the conversation, 
including the number of unread messages and whether one or more messages includes an 
attachment, is categorized, or is flagged for follow up.

When you receive a message that is part of a conversation, the entire conversation moves 
to the top of your Inbox and the new message appears when you click the conversation 
header. When a conversation includes unread messages, the conversation header is bold. 
When there are multiple unread messages, the number is indicated in parentheses follow-
ing the subject. The senders of the unread messages are listed below the subject.



	 Working with Conversation View    233

Split Conversations
When an e-mail conversation involves more than two people, it frequently happens that 
more than one person responds to the same message, and other people respond to each 
of those messages. Multiple conversations emerge from the primary conversation in a 
process that you might think of as branches growing out from a tree—each can split  
into additional branches that are farther and farther from the trunk (the original message). 
A conversation that contains multiple branches is called a split conversation. Within a 
split conversation, individual conversation branches are marked by orange and gray 
dots. Larger orange dots indicate the most current message in each branch. Small  
orange dots indicate older messages. Small gray dots indicate messages that may be 
considered redundant. Messages within each conversation branch are connected by 
orange and gray lines (referred to as visual threads). 

Tip  Conversation view isn’t new in Outlook 2010—it was first introduced in Outlook 2007—but 
it’s greatly improved and is now the default view for your Inbox and other message folders.

Viewing Conversations
You can display differing levels of messages within a conversation, as follows: 

●	 Click the conversation header or the Expand Conversation button to the left of the 
conversation header once to display the most recent message in the Reading Pane 
and to display the most recent message in each branch of a split conversation in 
the message list. These messages are indicated by orange dots.

Click the conversation header once to display only the most recent messages.
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●	 Click the conversation header again to expand the conversation to display all 
messages in the conversation.

Sent message

Expanded conversation

Current split
conversation message

Click the conversation header twice to display all messages.

●	 Click the most recent message in a split conversation to display the visual thread 
of that message branch.

Click a message to display its visual thread.

Conversation View Settings
By default, Conversation view displays messages stored in any folder, including sent 
messages that are stored in the Sent Items folder. (Within the expanded conversation, 
sent messages are indicated by italic font.) If you prefer to display only messages from 
the current folder, you can clear this setting on the Conversation Settings menu in the 
Conversation group on the View tab.
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Other settings that you can turn on include:

●	 Show Senders Above the Subject  This setting reverses the order of the information 
in the conversation header; you see the names of the conversation participants 
above the conversation subject. In some cases, such as when Outlook displays a 
message on the second line, the subject might not be visible at all.

The effect of the Show Senders Above The Subject setting in a split conversation.

●	 Always Expand Conversations  This setting causes Outlook to display all messages 
in a conversation when you click the conversation header once, rather than twice.

●	 Use Classic Indented View  This setting causes Outlook to indent older messages 
within individual message threads to show the progression of the thread. This 
setting is not as effective as the default for displaying split conversations because 
a message might be at the root of multiple branches but can appear only once in 
the message list.

The effect of the Use Classic Indented View setting.

Managing Conversations
Although the most apparent function of Conversation view is the grouping of related 
messages, its greatest usefulness is as a message-management tool. It can be especially  
handy for Outlook users within large organizations that use distribution lists to dis-
seminate information to a large group of people. When hundreds of message recipients  
use the Reply All function to respond to a message, your Inbox can quickly become 
cluttered. 
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Troubleshooting Conversation View

As with many “new and improved” features, Conversation view has its fans and 
its detractors. Many Outlook users appreciate the efficiency of the automatically 
grouped messages and not having to wade through as many messages in their 
Inboxes; others rue the fact that this new feature can cause messages to vanish, 
apparently, from their Inboxes before they’ve even seen them.

Conversation view can present a very efficient means of viewing messages within a 
multi-threaded conversation; however, it also has its drawbacks. Because Conversation 
view displays only certain messages within a conversation, a specific message that 
you’re looking for might not be visible within a conversation. If this happens, you can 
turn off Conversation view (by clearing the Show In Conversations check box in the 
Conversation group on the View tab) and then use one of these methods to locate  
the message you want to find:

●	 Sort the messages by subject, and then type the first few letters of the con-
versation subject to scroll those messages to the top of the Message pane.

●	 Enter the subject into the Search box at the top of the Message pane and then 
specify any other criteria (such as the sender or date) of the message that you’re 
looking for to narrow the results. 

After using either of these methods to display a set of messages, visually scan the 
messages to locate the one you’re looking for.

Conversation view enables you to manage all the messages within a conversation as a group. 
You can do this by clicking the conversation header to effectively select all the messages in 
the conversation (they won’t appear selected, but any action you apply to the conversation 
header applies to all the individual messages in the conversation) and then applying your 
action. Or you can use these new conversation-management tools:

●	 Ignore Conversation  This command moves the selected conversation and any 
related messages you receive in the future directly to the Deleted Items folder.

Keyboard Shortcut  Press Ctrl+Del to ignore the currently active conversation.

See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” 
at the end of this book.

Tip  Be cautious when using the Ignore Conversation command. Outlook identifies 
“conversations” based on message subjects. If you receive unrelated messages in the 
future that have the same message subject as a conversation that you’ve chosen to 
ignore, you won’t receive those messages.
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●	 Clean Up Conversation  This command deletes redundant messages—messages 
whose text is wholly contained within later messages—from a conversation. By 
default, Outlook doesn’t clean up categorized, flagged, or digitally signed mes-
sages. You can modify conversation clean-up settings on the Mail page of the 
Outlook Options dialog box.

See Also  For information about modifying mail settings, see “Personalizing Your Office 
and Outlook Settings” in Chapter 13, “Customize Outlook.”

Arranging Messages in Different Ways
As the number of messages in your Inbox increases, it can be challenging to keep track 
of them. You can arrange, group, and sort messages in Outlook to help you quickly 
determine which are the most important, decide which can be deleted, and locate 
any that need an immediate response.

See Also  For information about the available message folder views, see “Viewing Messages 
and Message Attachments” in Chapter 3, “Send and Receive E-Mail Messages.”

You can view a message list in Compact view, Single view, or Preview view. Regardless 
of the view you’re displaying, you can arrange messages and conversations within the 
message list by choosing a standard arrangement from the Arrangement gallery on 
the View tab.

The Arrangement gallery.

Alternatively, you can click the Arrange By bar at the top of the message list and then 
click an option in the Arrange By list.
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Message list header
Sort order

The Arrange By list.

Two options that affect the way messages appear within an arrangement are conversations 
and grouping. Both of these organizational options are turned on by default; you can turn 
either or both off.

See Also  For information about conversations, see “Working with Conversation View” earlier 
in this chapter.

Grouping gathers messages that fit within specific arrangement categories under 
arrangement-specific headings so that you can manage common messages as one. 
For example, when messages are arranged by date, they are grouped by date: groups 
include each day of the current week, Last Week, Two Weeks Ago, Three Weeks Ago, 
Last Month, and Older. 

Each group has a header. You can expand or collapse an individual group by clicking the 
arrow to the left of the group name in the header. You can collapse the group containing 
the currently selected item by pressing the Left Arrow key, and you can expand a selected 
group by pressing the Right Arrow key. You can expand or collapse all groups by choosing 
a command from the Expand/Collapse list in the Arrangement group on the View tab.
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By default, Outlook displays messages arranged by date, from newest to oldest. 
Alternatively, you can arrange items by any of the following attributes:

●	 Account  Messages are grouped by the e-mail account to which they were sent. 
This is useful if you receive messages for more than one e-mail account in your 
Inbox (for example, if you receive messages sent to your POP3 account within 
your Exchange account mailbox).

●	 Attachments  Messages are grouped by whether they have attachments and 
secondarily by date received.

●	 Categories  Messages are arranged by the category you assign them to. Messages 
without a category appear first. Messages assigned to multiple categories appear 
in each of those category groups.

●	 Flag: Start Date or Due Date  Unflagged messages and messages without specific 
schedules appear first. Messages that you’ve added to your task list with specific start 
or due dates are grouped by date.

●	 From  Messages appear in alphabetical order by the message sender’s display name. 
If you receive messages from a person who uses two different e-mail accounts, or 
who sends messages from two different e-mail clients (for example, from Outlook 
and from Windows Mail), the messages will not necessarily be grouped together.

●	 Importance  Messages are grouped by priority: High (indicated by a red exclamation 
point), Normal (the default), or Low (indicated by a blue downward-pointing arrow).

●	 To  Messages are grouped alphabetically by the primary recipients (the addresses 
or names on the To line). The group name exactly reflects the order in which 
addresses appear on the To line. Therefore, a message addressed to Bart Duncan; 
Lukas Keller is not grouped with a message addressed to Lukas Keller; Bart Duncan.

●	 Size  Messages are grouped by the size of the message, including any attachment. 
Groups include Huge (1–5 MB), Very Large (500 KB–1 MB), Large (100–500 KB), 
Medium (25–100 KB), Small (10–25 KB), and Tiny (less than 10 KB). This feature is use-
ful if you work for an organization that limits the size of your Inbox because you can 
easily locate large messages and delete them or move them to a personal folder.

●	 Subject  Messages are arranged alphabetically by their subjects and then by date. 
This is similar to arranging by conversation except that the messages aren’t threaded.

●	 Type  Items in your Inbox (or other folder) are grouped by the type of item—for 
example, messages, encrypted messages, message receipts, meeting requests and 
meeting request responses, tasks, Microsoft InfoPath forms, and server notifications.
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After arranging the items in your message list, you can change the sort order of the 
arrangement by clicking the sort order indicator that appears on the right side of  
the message list header.

Regardless of the view and arrangement you choose, you can sort messages by any 
visible column simply by clicking its column heading (and reverse the sort order by 
clicking the column heading a second time). You can change the displayed columns from 
the Show Columns dialog box, which you display by clicking the Add Columns button 
in the Arrangement group on the View tab.

The Show Columns dialog box.

Outlook displays the selected columns in the order shown in the list on the right side of 
the Show Columns dialog box. If displaying all the columns requires more space than is 
available, only some of the columns will be visible. If necessary, you can change the 
number of lines shown to accommodate more columns. However, you are likely to find 
that one of the standard views fits your needs.

In a list view, you can control the message arrangement, sorting, grouping, visible col-
umns, and other settings from the shortcut menu that appears when you right-click any 
column header.
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In this exercise, you’ll change the arrangement, sort order, and grouping of messages in 
your Inbox, and filter the Inbox content to display only specific messages. Then you’ll 
restore the default settings. 

SET UP  You don’t need any specific practice files to complete this exercise; just 
use the messages in your Inbox. Display your Inbox in Messages view, and then 
follow the steps.

	 1.	 In the Arrangement gallery, click From.

Outlook rearranges and groups the messages in your Inbox alphabetically by sender.

The Sort Order indicator changes to match the selected arrangement.

	 2.	 In the message list header, click A on top.

Outlook reverses the order of the messages and changes the sort order in the 
message header to Z On Top.
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	 3.	 In the message list header, click the Arrange By bar, and then click Subject.

Outlook rearranges and groups the messages by subject, in alphabetical order.

	 4.	 In the Arrangement group, click the Expand/Collapse button and then, in the list, 
click Collapse All Groups.

Only the group headers are visible. There is a group header for each message or 
set of messages with the same subject.

Collapsing groups of messages displays only the group headers. 

Notice that the number of unread items in each group (if there are any) is indicated 
in parentheses following the conversation subject.

	 5.	 On the Home tab, in the Find group, click the Filter E-mail button.

The Filter E-mail list expands. The list contains the same options that are present 
on the Search contextual tab.

In the Filter E-mail list, you can specify one or more criteria for the messages that are 
shown in the message list.
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	 6.	 In the Filter E-mail list, click Unread.

Outlook enters the specified filter in the Search box at the top of the message list 
and filters your Inbox to display only unread messages. (If you have no unread 
messages in your Inbox, it appears to be empty.)

The Search box and Search contextual tab indicate the applied filter.

Troubleshooting  The appearance of buttons and groups on the ribbon changes 
depending on the width of the program window or item window. For information 
about changing the appearance of the ribbon to match our screen images, see 
“Modifying the Display of the Ribbon” at the beginning of this book.

	 7.	 On the Search tab, in the Close group, click the Close Search button.

Outlook removes the filter and returns to the previous arrangement.

	 8.	 Experiment with the available arrangement, sorting, and grouping options.

	 9.	 On the View tab, in the Current View group, click the Reset View button. Then in 
the Microsoft Outlook dialog box that asks whether to reset the view, click Yes.

The message list returns to its original arrangement: grouped, by date, in 
conversations.

CLEAN UP  Arrange your Inbox content in the way that works best for you. Retain 
the default view settings before continuing, if you want them to match those 
shown in the rest of this book.
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Marking Messages as Read or Unread
When a new message arrives in your Inbox, its header is bold and its icon depicts a 
closed envelope to indicate that you haven’t yet opened the message—its status is 
unread. When you open a message in a message window or preview it for a certain 
length of time in the Reading Pane, its status changes to read. The message header 
is no longer bold, and its icon depicts an open envelope.

You might want to change the status of a message from read to unread, to remind you  
to revisit it, or from unread to read, if you know from the message subject that you don’t  
need to take action on it.

You can manually change the status of a message by using these methods:

●	 Click a message in the message list or select multiple messages, and then on 
the Home tab, in the Tags group, click the Unread/Read button.

●	 Right-click a message or one of a group of selected messages in the message 
list, and then click Mark As Read or Mark As Unread.

Tip  The shortcut menu that appears when you right-click an item shows only the 
available option.

●	 Right-click a folder in the Navigation Pane, and then click Mark All As Read.

Keyboard Shortcuts  Press Ctrl+Q to mark a message as read. Press Ctrl+U to mark a 
message as unread.

Organizing Outlook Items by Using Color Categories
To help you more easily locate Outlook items associated with a specific subject, project, 
person, or other condition, you can create a category specific to that condition and assign  
the category to any related items. You can assign a category to any type of Outlook item— 
a message, an appointment, a contact record, a note, and so on. For example, you might 
assign contact records for customers to a Customers category. 

Outlook uses color categories, which combine named categories with color bars to 
provide an immediate visual cue when you view messages in your Inbox, appointments 
on your calendar, and so on. Depending on the view of the Outlook items, the category 
may be indicated by a simple colored block or a large colored bar.
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Category bars

Category blocks

Category bars include the category name.

Tip  You can locate, sort, and filter Outlook items by category. For information, see “Quickly 
Locating Messages” later in this chapter.

Outlook 2010 comes with six pre-configured color categories that are associated only with 
the color names. You can rename the six starting categories and create new categories. 
Each category can have the following elements:

●	 Name  The category name can be one simple word or a long, descriptive phrase. 
The first 32 characters of the category name are visible in the color categories 
dialog box, but pointing to a truncated name displays a ScreenTip containing 
the entire name.

●	 Shortcut key  You can assign any of the 11 available keyboard shortcut combinations 
(CTRL+F2 through CTRL+F12) to a color category. (You can assign only these 11 
keyboard shortcuts within the dialog box.) By using a keyboard shortcut, you can 
assign a frequently used category in one step.

●	 Color  You can assign any of the 25 available colors to a category, or you can 
choose not to assign a color. (You can’t choose colors other than the 25 shown.) 
When you assign a category that doesn’t have an associated color to an Outlook 
item, the color block or color bar is shown as white. You can assign one color to 
multiple categories.
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You can assign any of 25 colors to a category.

One category is designated as the Quick Click category. Outlook assigns the Quick Click 
category by default when you simply click the Category box or column associated with 
an item. You can change the Quick Click category by clicking Set Quick Click on any one 
of the Categorize menus and then making your selection in the Set Quick Click dialog 
box that appears.

The Quick Click category is applied by default when you click a Category bar.

Tip  You can also set the Quick Click category on the Advanced page of the Outlook Options 
dialog box. For more information, see “Personalizing Your Office and Outlook Settings” in 
Chapter 13, “Customize Outlook.”

You can apply a color category to a selected item or items by using any of these methods:

●	 In any mail or contacts folder, click the Categorize button in the Tags group on the 
Home tab, and then in the list, click the category you want.

●	 In any message list, click in the Categories column to assign the Quick Click category.

●	 In any calendar, click the Categorize button in the Tags group on the contextual tab 
(Appointment, Meeting, and so on) that appears for the selected item, and then 
click the category you want.

●	 In any folder, right-click an item or a selection of items, point to Categorize, and 
then click the category you want.



	 Organizing Outlook Items by Using Color Categories    247

To quickly view the messages belonging to a category, you can group messages by 
category or include the category in a search. In a list view of any module, you can sort 
and filter by category. On the To-Do Bar, you can arrange your flagged messages and 
tasks by category.

Tip  You can instruct Outlook to automatically assign a category to an incoming message that 
meets specific criteria by creating a rule. For more information, see “Creating Rules to Process 
Messages” in Chapter 11, “Manage E-Mail Settings.”

In this exercise, you’ll change the name and color of an existing category, assign a shortcut 
key to a category, and create categories. Then you’ll categorize a message, and experiment 
with organizing your Inbox contents by using categories.

SET UP  You need the SBS Tradeshow Schedule, SBS First Draft, RE: SBS First Draft, 
and FW: SBS First Draft messages you created in Chapter 3, “Send and Receive 
E-Mail Messages.” If you have not already created these messages, you can do so 
now, or you can substitute any messages in your Inbox. Display your Inbox, and 
then follow the steps.

	 1.	 In the message list, click the SBS Tradeshow Schedule message.

	 2.	 On the Home tab, in the Tags group, click the Categorize button.

The Categorize list displays the available categories. Notice that you can remove 
all categories from a selected message or group of messages by clicking Clear All 
Categories.

If you haven’t yet worked with categories, the Categorize list includes only the six standard 
categories named for their colors.



248    Chapter 7  Organize Your Inbox

	 3.	 In the Categorize list, click All Categories.

The Color Categories dialog box opens, displaying the currently available 
categories.

You can rename any of the standard color categories or create new color categories.

	 4.	 In the Color Categories dialog box, click the Blue Category name (not the check 
box), and then click Rename.

Troubleshooting  If you have already renamed the standard categories, you can either 
create or rename a different category.

	 5.	 With the category name selected for editing, type Management, and then press 
Enter.

Troubleshooting  Don’t click OK—doing so closes the dialog box.

The category name changes. The category order doesn’t immediately change, 
but the next time you display the categories in a list or dialog box, they are  
reordered alphabetically.

Tip  If you don’t rename a standard color category before assigning it for the first time, 
Outlook gives you the option of renaming the category the first time you use it.

	 6.	 With the Management category still selected, click the Color arrow, and then in 
the lower-right corner of the color palette, click the Dark Maroon square.

The color associated with the Management category changes from Blue to Dark 
Maroon.

	 7.	 Repeat steps 4 and 5 to rename the Orange Category as Travel Required.
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	 8.	 In the Color Categories dialog box, click New.

The Add New Category dialog box opens.

	 9.	 In the Name box, type Marketing. Click the Color arrow and then, in the color 
palette, click the Dark Green square. Then click the Shortcut Key list.

The list expands to display the keyboard shortcuts available to color categories.

Assign keyboard shortcuts to categories that you use frequently, to save time.

	 10.	 In the Shortcut Key list, click CTRL+F2. Then in the Add New Category dialog 
box, click OK.

The new category appears at the bottom of the color categories list. Its selected 
check box indicates that it has been assigned to the currently selected message.

	 11.	 In the Color Categories dialog box, click the Green Category name (not the check 
box), and then click Delete. In the Microsoft Outlook dialog box confirming that 
you want to delete the category, click Yes.

Keyboard Shortcut  Press Alt+D to delete the selected category from the color 
categories dialog box.

The Green Category disappears from the list.

	 12.	 In the Color Categories dialog box, click OK.

In the message list and in the To-Do Bar Task List, the Category box of the selected 
message changes to a dark green square. In the Reading Pane, a dark green bar 
with the category name Marketing appears at the top of the message.
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	 13.	 In the SBS Tradeshow Schedule message header, right-click the Category box.

The shortcut menu displays the color category options in alphabetical order.

Right-clicking any Category box displays the Categorize list content.

	 14.	 On the shortcut menu, click Travel Required.

The second category box appears in the message header and in the To-Do  
Bar Task List.

Tip  You can assign an unlimited number of categories to a message, but only the 
three most recently assigned appear in the message header.

The Reading Pane displays two colored category bars. If you assign more than 
three categories to a message, Outlook displays additional rows of category bars.

Category bars

Assigned categories are visible in the message list, Reading Pane, and To-Do Bar. 

	 15.	 In the message list, expand the SBS First Draft conversation twice to display its 
messages. Click any message in the conversation, and then press Ctrl+F2.
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The Marketing category is assigned to the selected message and also appears  
in the conversation header.

	 16.	 Click another message in the SBS First Draft conversation. On the Home tab, in the 
Tags group, click the Categorize button and then, in the list, click Management.

The Management category is assigned to the selected message, and also appears 
as a second category in the conversation header.

	 17.	 In the message list header, click the Arranged By bar and then, in the list, click 
Categories.

The messages are arranged by category, beginning with the uncategorized messages 
(None), followed by the categorized messages in alphabetical order by category.

	 18.	 To the right of the Arranged By bar, click A on top.

The sort order reverses to display the categorized messages (in reverse alphabetical 
order) at the top of the list.

You can quickly locate categorized messages by changing the message list arrangement.

CLEAN UP  Return the message list to its default Date arrangement before continuing 
to the next exercise. Retain the SBS Tradeshow Schedule, SBS First Draft, RE: SBS First 
Draft, and FW: SBS First Draft messages for use in later exercises.
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Recording Information by Using Outlook Notes

You can store miscellaneous information such as reminders, passwords, account 
numbers, and processes by recording them as electronic notes. Because your 
notes are available to you from wherever you access Outlook, this can be a very 
convenient way of retaining information you might need later. And because 
you’re less likely to accidentally delete a note than a message, it is safer than 
sending information to yourself in an e-mail message.

Although notes are a type of Outlook item, they don’t appear in the same type 
of windows as messages, appointments, contact records, and tasks. Instead, they 
appear in the form of “sticky notes” resembling the popular 3M-brand Post-It  
notes. You can view, sort, and organize notes in the same way you do other 
Outlook items. The standard views include:

●	 Icons

●	 Notes List

●	 Last Seven Days

You switch the view by clicking the View you want in the Current View gallery on 
the Home tab. If you’re looking for a specific piece of information in a note, you 
can quickly locate it by typing a search word or phrase in the Search Notes box 
above the content pane.

By default, the Reading Pane is hidden in the Notes pane, but if you prefer, you 
can display the Reading Pane and view the content of notes without opening 
them. To do so, click the Reading Pane button on the View tab, in the Layout 
group, and then click Right or Bottom to display the Reading Pane in that 
location.

You can enter only text into a note; you can’t format the text. If you paste formatted 
text into a note, it will change to the default font. 
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Tip  Notes do support hyperlinks; if you enter a Web site address and then press 
Enter, the Web site address will change to blue, underlined text to indicate that 
it is a hyperlink. You can click the hyperlink to open the Web site or page in your 
default Web browser.

By default, note icons and sticky note representations are a pale yellow color, like 
the color of standard paper sticky notes. When you assign a category to a note, the 
note color changes to the category color.

You can change the default note color (you have the choice of white or a pastel 
shade of blue, green, pink, or yellow), size (small, medium or large), or font (any 
font installed on your computer) from the Notes and Journal page of the Outlook 
Options dialog box.

To store information in a note:

	 1.	 In the Navigation Pane, click the Notes button.

Outlook displays the Notes pane.

	 2.	 On the Home tab, in the New group, click the New Note button.

Outlook displays a new note. The current date and time appear at the 
bottom.

	 3.	 Enter the subject or title of the note, press Enter, and then enter the information 
you want to store into the note. 

The first line of the note becomes its subject or title.

	 4.	 To save and close the note, click the Close button in the upper-right corner.

The note appears in the Notes pane. Only the subject is visible. You can 
access the stored information by opening the note (or by displaying the 
Reading Pane).
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Organizing Messages in Folders
After you’ve read and responded to messages, you might want to keep some for future 
reference. You can certainly choose to retain them all in your Inbox if you want, but 
as the number of messages in your Inbox increases to the hundreds and even into the 
thousands, it might quickly become overwhelming. To keep your Inbox content low and 
avoid an accumulation of unrelated messages, you can organize messages into folders. 
For example, you can keep messages that require action on your part in your Inbox and 
move messages that you want to retain for future reference into other folders.

Tip  Because the Outlook Search function provides the option of searching within all folders 
containing items of a particular type, you can easily locate a message that’s been moved to 
a folder without having to remember exactly which folder it’s in. For more information, see 
“Quickly Locating Messages” later in this chapter.

Popular personal-organization experts advocate various folder structures (for paper 
folders as well as for e-mail message folders) as an important part of an organizational 
system. You can apply any of these ideas when you create electronic folders in Outlook, 
or you can use any other structure that works for you. For example, you might create a 
folder for each project you’re working on and store all messages regarding a particular 
project in its own folder. Or you might create a folder to store all messages from a par-
ticular person, such as your manager, regardless of the message subject.

When you create a folder, you specify the location of the folder within your existing 
Outlook folder structure and the type of items you want the folder to contain. You can 
create folders to contain the following types of items:

●	 Calendar items

●	 Contact items

●	 InfoPath Form items

●	 Journal items

●	 Mail and Post items

●	 Note items

●	 Task items

The selection you make governs the folder icon that precedes its name in the folder list, the 
folder window layout, the ribbon tabs and commands available in the folder, and the con-
tent of the Navigation Pane in the folder.
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You can move messages to folders manually, or if your organization is running 
Exchange, you can have Outlook move them for you. You can automatically move 
messages to another folder by creating a rule—for example, you can instruct Outlook 
to automatically move all messages received from your manager to a separate folder. 
You can set up different rules that go into effect when you’re away from the office.

See Also  For information about automatically moving messages, see “Creating Rules to 
Process Messages” in Chapter 11, “Manage E-Mail Settings.”

In this exercise, you’ll create a folder and then use different methods to move messages 
to the folder.

SET UP  You need the SBS First Draft, RE: SBS First Draft, and FW: SBS First Draft 
messages you worked with in the previous exercise. If you have not already created 
these messages, you can do so now, or you can substitute any messages in your 
Inbox. Display your Inbox, and then follow the steps.

	 1.	 On the Folder tab, in the New group, click the New Folder button.

Keyboard Shortcut  Press Ctrl+Shift+E to create a new folder.

The Create New Folder dialog box opens.

The default settings in the Create New Folder dialog box match the active module at the 
time you create the folder.
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Troubleshooting  If your default data file (the file in which your messages are stored) 
is a personal folder on your hard disk, the first item in the Select Where To Place The 
Folder box is Personal Folders.

	 2.	 In the Name box, type SBS Messages. In the Select where to place the folder 
box, click Inbox. Then, with Mail and Post Items selected in the Folder contains 
list, click OK.

Tip  The name of this folder begins with SBS so that you can easily differentiate it from 
other folders in your mailbox.

Because you created this folder from the Inbox, Outlook creates the new folder as a 
subfolder of the Inbox, and formats it to contain mail items.

The new folder will display the ribbon tabs of the Mail module because you designated 
that it will contain Mail items.

	 3.	 In the message list, locate the SBS First Draft, RE: SBS First Draft, and FW: SBS 
First Draft messages.

	 4.	 Drag the SBS First Draft message from the message list to the SBS Messages 
folder in the Navigation Pane.

The message moves from the Inbox to the SBS Messages folder.

	 5.	 Click the RE: SBS First Draft message to select it. Then on the Home tab, in the 
Move group, click the Move button.

The Move list expands, displaying a list of folders and other move options.
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The Move list automatically includes folders that you create.

	 6.	 In the Move list, click SBS Messages.

The selected message moves from the Inbox to the SBS Messages folder.

	 7.	 Right-click the FW: SBS First Draft message, click Move, and then click SBS Messages.

The conversation disappears from the Inbox. 

Tip  When you move the last message of a conversation from the Inbox, related messages 
stored in other folders disappear.

	 8.	 In the Navigation Pane, under the Inbox folder, click the SBS Messages folder.

The messages are visible in the new folder as part of a conversation.

	 9.	 Expand the conversation header once.

All the messages in the conversation are visible in the list.

Messages that aren’t in the current folder are shown in italics. 

CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.
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Managing Messages by Using Quick Steps
A convenient new feature of Outlook 2010 is Quick Steps, which allow you to perform 
multiple tasks on messages by clicking only one button. Quick Steps are available from 
the Quick Steps gallery on the Home tab of any mail folder.

The default Quick Steps gallery.

You can use the built-in Quick Steps or create your own to accomplish as many as 12 
tasks at once.

A default Outlook installation includes these five Quick Steps:

●	 Move To  Moves the selected message to a folder that you specify the first time you 
use the Quick Step and marks the message as read. After you specify the folder, the 
Quick Step name changes to include the folder name.

●	 Team E-mail  Creates a message to a person or people you specify the first time you 
use the Quick Step. You can edit the Quick Step to include Cc and Bcc recipients, a 
specific message subject, a follow-up flag, a level of importance, and specific mes-
sage text, and to automatically send the message one minute after you click the 
Quick Step command.

●	 Reply & Delete  Creates a response to the original message sender and immediately 
deletes the original message.

Troubleshooting  The Reply & Delete Quick Step deletes the original message before 
you send the reply. If you close the response message composition window without 
sending it, the original message will no longer be in your Inbox. If you want to respond 
to the original message, you first need to retrieve it from your Deleted Items folder.

●	 To Manager  Forwards the selected message to a person or people you specify the 
first time you use the Quick Step. You can edit the Quick Step to include Cc and Bcc 
recipients, a specific message subject, a follow-up flag, a level of importance, and 
specific message text, and to automatically send the message one minute after you 
click the Quick Step command.

●	 Done  Moves the selected message to a folder that you specify the first time you use 
the Quick Step, marks the message as read, and marks the message as complete so 
that a check mark is displayed in the follow-up flag location.
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For each of the built-in Quick Steps, you can change its name; edit, add, and remove 
actions; and specify tooltip text that appears when you point to the Quick Step in the 
Quick Steps gallery. You can assign shortcut keys (Ctrl+Shift+1 through Ctrl+Shift+9) to 
up to nine Quick Steps.

Tip  You can create new Quick Steps to simplify the performance of many types of message-
management actions. For more information, see “Creating and Managing Quick Steps” in 
Chapter 13, “Customize Outlook.”

In this exercise, you will set up and use a built-in Quick Step.

SET UP  Use the SBS Tradeshow Schedule message you worked with earlier in this chapter 
and the SBS Messages folder you created in the previous exercise. If you did not create 
these practice files, you can do so now or substitute any message and folder in your 
Inbox. Display your Inbox, locate the SBS Tradeshow Schedule message, and then 
follow the steps.

	 1.	 On the Home tab, in the Quick Steps gallery, click Move to: ?.

The First Time Setup dialog box for the selected command opens.

Some generic Quick Steps require that you supply information the first time you use them.

	 2.	 Click the Move to folder arrow and then, in the list, click SBS Messages.

In the Name box, the name of the Quick Step changes from Move To: ? to SBS 
Messages.

	 3.	 In the First Time Setup dialog box, click Options.

The Edit Quick Step dialog box opens.
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The Move To command doesn’t include many standard options.

Notice that you can change the existing actions (Move To Folder and Mark As 
Read) and add actions to the standard Quick Step.

	 4.	 In the Tooltip text box, select the existing text and then type Move and mark 
as read.

	 5.	 In the Edit Quick Step dialog box, click Save.

In the Quick Step gallery, the Quick Step name changes from Move To: ? to SBS 
Messages.

	 6.	 In the message list, click the SBS Tradeshow Schedule message to select it.

	 7.	 In the Quick Steps gallery, point to SBS Messages.

Your custom tooltip appears below the ribbon.
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You can supply custom tooltip text for any Quick Step.

	 8.	 In the Quick Steps gallery, click SBS Messages.

The selected message disappears from the message list.

	 9.	 In the Navigation Pane, under the Inbox folder, click the SBS Messages folder.

The message has been moved to the designated folder. 

The categories and follow-up flag of the moved message are intact.

CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.

Quickly Locating Messages
The Outlook Search feature is based on the Windows Search technology that is built into 
Windows 7 and Windows Vista Service Pack 2. Using the Windows Search technology, 
you can find any file on your computer that contains a specified search term—whether 
in a file or folder name, in document or workbook content, in an e-mail message within 
Outlook, in a message attachment, in a picture, music, or video file, and so on. (As a 
matter of fact, if you prefer to do so, you can conduct all of your Outlook searches from 
the Windows Start menu.)
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You can use the Search feature to locate specific terms in any Outlook item. Although you 
can search for items in the Calendar, Contacts, Tasks, and Notes modules, you most often 
use it to locate messages in your Inbox and other mail folders. The Search feature can 
locate search terms in a message or in a file attached to a message. As you enter a search 
term in the Search box located at the top of the content pane in any module, Outlook 
filters the items to show only those items in the module that contain the search term and 
highlights the search term in the list of results.

If the search term you enter produces more than 200 results, only the first 200 are 
displayed, and an information bar appears in the Search Results pane.

Search displays only the first 200 available results unless you request more.

You can display all the results for the current search term by clicking the message bar, 
or you can narrow the results by expanding the search term or by specifying other 
search criteria, such as the sender, the recipient (whether the message was addressed 
or only copied to you), a category assigned to the item, whether the message contains 
attachments, and so on.

Outlook 2010 features the Search contextual tab. This ribbon tab appears when you 
activate the Search box in any Outlook module. You can enter search terms into the 
Search box and refine your search by using the commands on the Search contextual tab.

The Search tab appears when you click in a Search box or filter the contents of a message folder.

When searching any folder, you can use the commands on the Search tab to set the 
scope of the search and to more closely define the search specifications. You can also 
return to the results of previous searches.

See Also  For information about Windows 7 search features, refer to Windows 7 Step by Step 
by Joan Lambert Preppernau and Joyce Cox (Microsoft Press, 2009).



	 Quickly Locating Messages    263

The buttons available in the Scope and Refine groups vary based on the type of folder 
you’re searching. The Scope group always offers the options of the current folder, all 
subfolders, all folders of the current type, and all Outlook items. The commands in the 
Refine group change to reflect common properties of items stored in the current folder 
type. The most common properties are shown as buttons in the Refine group; additional 
properties are available for selection from the More list.

You can search for an item based on any property.

When you click a button in the Refine group or a property in the More list, that property 
appears in the Search box with a placeholder for you to specify the value you’re looking 
for. As you define the criteria for a search, Outlook filters out all messages that don’t 
match, which makes it easy to find exactly what you’re looking for. And here’s the neat 
thing: Outlook searches not only the content of the e-mail message header and the  
message itself, but also the content of message attachments. So if the search term you’re 
looking for is in a Microsoft Word document attached to a message, the message is 
included in the search results.

Tip  If your organization uses Public Folders (a feature of Exchange) you can use these same 
tools to search a Public Folder, but the content isn’t filtered instantly; you must press Enter or 
click the Search button to get the same results as you would in a standard account folder.
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Using Search Folders

A Search Folder displays all the messages in your mailbox that match a specific 
set of search criteria, no matter which folders the messages are actually stored in. 
When you create a Search Folder, it becomes part of your mailbox and is kept up to 
date. The Search Folder module is located in the Navigation Pane under your top-
level mailbox, at the same level as the Inbox.

Outlook 2010 doesn’t include any standard Search Folders. If you want quick access 
to messages that fit a specific set of criteria, you can create a custom Search Folder. 
To do so, follow these steps:

	 1.	 Display any mail folder.

	 2.	 On the Folder tab, in the New group, click New Search Folder.

Keyboard Shortcut  Press Ctrl+Shift+P to create a Search Folder.

The New Search Folder dialog box opens.

Search Folder categories include Reading Mail, Mail From People And Lists, Organizing 
Mail, and Custom.
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	 3.	 In the New Search Folder dialog box, select the type of Search Folder you 
want to create, and then click OK.

You can choose from the standard options presented or click Create A 
Custom Search Folder to specify other search options.

You can make changes to the contents of an existing Search Folder by right-clicking 
the folder and then clicking Customize This Search Folder.

Outlook automatically keeps Search Folder contents up to date. The names of 
folders containing unread items are bold, followed by the number of unread 
items in parentheses. The names of folders containing items flagged for follow up 
are bold, followed by the number of flagged items in square brackets. The names 
of folders whose contents are not up to date are italic. To update a Search Folder, 
click the folder name.

Each message in your mailbox is stored in only one folder (such as your Inbox), but 
it might appear in multiple Search Folders. Changing or deleting a message in a 
Search Folder changes or deletes the message in the folder in which it is stored.

In this exercise, you’ll use the Search feature to locate a specific message in your Inbox. 

SET UP  Use the SBS First Draft, RE: SBS First Draft, FW: SBS First Draft, and SBS 
Tradeshow Schedule messages, and the SBS Messages folder, you worked with earlier 
in this chapter. If you didn’t create those practice files, you can do so at this time or 
substitute messages and a folder of your own. Display your Inbox and the Reading 
Pane, and then follow the steps.

	 1.	 In the Search box at the top of the message list, type the.

Keyboard Shortcut  Press F3 or Ctrl+E to move the cursor to the Search box.

As you type, the Search contextual tab appears on the ribbon, and options for 
refining your search appear below the Search box.

Selecting an option other than Keyword enters the alternative search criterion (and term) 
in the Search box.
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Outlook filters the messages in your Inbox to include only those that contain the 
word the, and highlights all occurrences of the word in the message list and in 
the active message.

Initial search results include only messages contained in the Inbox folder and not in any of 
its subfolders or any other mailbox folders.

In the lower-left corner of the program window, the status bar displays the number 
of messages included in the search results.

	 2.	 On the Search tab, in the Refine group, click the Subject button.

Outlook adds the subject criterion to the Search box and prompts you to enter 
keywords that should appear in the Subject field of all search results.

You replace the placeholder with the words you want to find in the subject field.

	 3.	 With keywords highlighted, type SBS.

Outlook instantly updates the search results to display only the messages in your 
Inbox that contain the word the and have SBS somewhere in the Subject field. 

If you’ve followed along with all the exercises in this chapter, it’s likely that the current 
search returns no results.

	 4.	 On the Search tab, in the Scope group, click the All Subfolders button.
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Keyboard Shortcut  Press Ctrl+Alt+Z to expand a search to include subfolders. Press 
Ctrl+Alt+A to expand a search to include all items of the current type.

The SBS First Draft conversation and SBS Tradeshow Schedule message that you moved 
to the SBS Messages subfolder in previous exercises appear in the search results.

	 5.	 In the message list header, click the Arrange By bar, and then click Folder.

The search results change to reflect the new arrangement.

Grouping the results of a search that includes All Subfolders by folder can help you to  
locate messages.

	 6.	 In the Options group, click the Recent Searches button.

Your recent searches are saved so that you can use the same search again at 
another time. 

Clicking a previous set of search criteria reruns that search against your current items.

	 7.	 Experiment with locating information by specifying criteria. When you finish, click 
the Close Search button to remove the filter and redisplay the Inbox message list.

Keyboard Shortcut  Press Esc to clear the search results.

CLEAN UP  Retain the SBS Messages folder and its contents for use in later exercises.
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Printing Messages
Although electronic communications certainly have less environmental impact than 
paper-based communications, you might from time to time want or need to print 
an e-mail message—for example, if you want to take a hard copy of it to a meeting 
for reference, or if you keep a physical file of important messages or complimentary 
feedback. You can print the message exactly as it appears in your Inbox or embellish 
it with page headers and footers. Outlook prints the message as shown on-screen, 
including font and paragraph formats.

In this exercise, you’ll preview a message as it will appear when printed, add a page 
header, and then print the message.

Important  To fully complete this exercise, you must have a printer installed. If you don’t have 
a printer installed, you can perform all steps of the exercise other than printing.

To install a printer, click the Start button, click Devices And Printers, and then on the toolbar, 
click Add A Printer. Follow the wizard’s instructions to install a local or network printer. Your 
network administrator can provide the information you need to install a network printer.

SET UP  You need the SBS Tradeshow Schedule message you worked with earlier 
in this chapter. If you did not create that message, you can do so now, or you can 
substitute any message in your Inbox. Open the SBS Tradeshow Schedule message, 
and then follow the steps.

	 1.	 In the message window, display the Backstage view, and then click Print.

The Print page of the Backstage view displays the current print settings.

The Print page of the Backstage view.
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The right pane displays the message as it will appear when printed, if you click the 
Print button without changing the settings shown in the center pane. If necessary, 
you can adjust the following settings:

❍	 Printer  Select an installed printer or add a new one.

❍	 Print Options  Opens the Print dialog box, where you can change the default 
printing options before printing. You can also change an existing print style (the 
way the message is presented on the printed page) or create a new one.

❍	 Print Style  Choose from the existing print styles available for the selected mes-
sage or other Outlook item. The default print style is Memo style, which prints 
your name, the message header information, and then the message content.

	 2.	 Click the Print Options button.

The Print dialog box opens, displaying your default printer settings, which you can 
change before printing. Clicking OK prints the message with the current settings.

The Print dialog box displaying the basic Memo Style for printing a message.

	 3.	 In the Print dialog box, click Page Setup.
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The Page Setup: Memo Style dialog box opens. You can change the font, paper 
size, page margins, header, and footer from this dialog box.

	 4.	 In the Page Setup: Memo Style dialog box, on the Format page, click the Font 
button.

The Font dialog box opens.

	 5.	 In the Font list, click Arial. In the Font style list, click Narrow Bold Italic. Then 
click OK.

	 6.	 In the Page Setup: Memo Style dialog box, click OK, and then click Preview in 
the Print dialog box.

	 7.	 In the lower-right corner of the Print page of the Backstage view, click the Actual 
Size button to display the message at 100 percent of its size.

The right pane of the Print page displays the message as it will appear when printed, 
with the header text in Arial Narrow Bold Italic.

You can preview the message at its full size.

Tip  If a message will be longer than one page when printed with the current settings, 
you can click the Multiple Pages button to preview all pages of the message at the same 
time. You might find this useful when, for example, you want to check page breaks or 
scan a document for a particular element.

	 8.	 Click Print Options, click Page Setup, and then in the Page Setup: Memo Style 
dialog box, click the Paper tab to see the available options.

In addition to choosing the paper size, you can select the number of pages that will 
be printed on each sheet of paper, and set the page margins and the orientation.
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The Paper page of the Page Setup dialog box.

	 9.	 Click the Header/Footer tab.

	 10.	 In the Header area, type For Your Information in the center box, and then click the 
Font button above the box. In the Font dialog box, under Size, click 16, and then 
click OK.

The text you entered doesn’t reflect the font size change, but the Header box to the 
left of the Font button indicates the current font selection.

	 11.	 In the Footer section, select the default text (the page number) that appears in the 
center box. Then in the AutoText box that appears near the bottom of the Page 
Setup dialog box, click the User Name button.

Outlook will print the specified text at the top of the page and your name (or user 
name, if different) at the bottom.

	 12.	 In the Page Setup dialog box, click OK, and then in the Print dialog box, click Print.

Troubleshooting  If the Save As dialog box opens, you do not have a printer installed.

Outlook prints the message, including your custom header and footer, to the active 
printer.

CLEAN UP  If you don’t want to retain the custom header and footer as part of the 
standard message printing template, remove them from the Memo Style. Then close 
the SBS Tradeshow Schedule message.
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Deleting Messages
When you delete a message, contact record, or any other item, Outlook temporarily moves 
it to the Deleted Items folder of your mailbox. You can open the folder from the Navigation 
Pane, view items that have been deleted but not purged, and restore items (undelete them) 
by moving them to other folders.

Keyboard Shortcut  Press Shift+Delete to permanently delete a message from a message list 
without first moving it to the Deleted Items folder.

By default, Outlook does not permanently delete items until you purge them from the 
Deleted Items folder. You can empty the entire Deleted Items folder manually or auto-
matically, or you can permanently delete individual items from it.

To permanently delete an individual item, follow these steps:

	 1.	 In the Navigation Pane, click the Deleted Items folder to display its contents.

	 2.	 In the Deleted Items list, click the item (or select multiple items) you want to 
delete.

	 3.	 On the Home tab, in the Delete group, click the Delete button (or press the 
Delete key).

	 4.	 In the Microsoft Outlook message box asking you to confirm that you want to 
permanently delete the selected item(s), click Yes.

To manually empty the Deleted Items folder, follow these steps:

●	 In the Navigation Pane, right-click the Deleted Items folder, and then click 
Empty Folder.

To automatically empty the Deleted Items folder each time you exit Outlook, follow 
these steps:

	 1.	 Display the Backstage view, and then click Options.

	 2.	 On the Advanced page of the Outlook Options dialog box under Outlook Start 
And Exit, select the Empty Deleted Items Folder When Exiting Outlook check 
box. Then click OK.
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Key Points
●	 You can filter and locate messages in your mailbox by using the Search feature.

●	 You can group and sort messages by sender, time, subject, size, category, or any 
other field.

●	 You can assign color-coded categories to messages and then group and sort items 
by color category. You can use the default Outlook categories or tailor them to fit 
your needs.

●	 You can record miscellaneous information in electronic notes. You can categorize, 
search, display, and sort notes, and send notes to other people.

●	 You can create folders to organize your mail, and move items to folders manually 
or automatically.

●	 You can print a message when you need a paper copy. You can select from several 
print styles and make modifications to the print styles to suit your needs.

●	 When you delete a message or other Outlook item, it moves to the Deleted Items 
folder and is not permanently deleted until you empty the folder.
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	10	 Enhance 
		  Message Content

In this chapter, you will learn how to
✔	 Personalize the appearance of message text.
✔	 Embed and modify images.
✔	 Create and format business graphics.
✔	 Change message settings and delivery options.

Messages composed in and sent from Microsoft Outlook 2010 don’t have to consist only 
of plain text. They can contain diagrams and graphics and can be visually enhanced by 
a judicious use of colors, fonts, and backgrounds. For more formal messages, you can 
attach a signature that includes your contact information as well as graphics such as a 
photograph or logo.

In this chapter, you’ll first review formatting techniques, set default fonts for new messages  
and message responses, and create an e-mail signature that‘s automatically included in 
all new messages. Then you’ll insert and modify pictures, Clip Art, and shapes, and use 
the new Screenshot and Screen Clipping tools to capture images of content displayed on 
your screen. You’ll create and format graphical representations of business information 
and data. Finally, you’ll learn about the message settings and delivery options you can 
set for outgoing messages.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter10 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.
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Personalizing the Appearance of Message Text
By default, the text content of an Outlook message is shown in black, 11-point Calibri (a font 
chosen for its readability), arranged in left-aligned paragraphs on a white background. You  
can change the appearance of the text in a message by applying either local formatting 
(character or paragraph attributes and styles that you apply directly to text) or global 
formatting (a theme or style set that you apply to the entire document) in the same way 
that you would when working in a Microsoft Word document or Microsoft PowerPoint 
presentation. However, if you have a preferred font or theme for the messages you 
compose, you can save your preferences so that Outlook automatically applies it to 
new messages and to message responses.

Formatting Message Text
You set your default font and theme preferences from the Signatures And Stationery 
dialog box, which you open by clicking Stationery And Fonts on the Mail page of the 
Outlook Options dialog box. You have the option of specifying one default font for new 
messages and another for message responses. You might do this if you need to visually 
differentiate between original messages and responses. For example, you might com-
pose original messages in a dark blue font, and compose message responses in a  
medium blue font.

The Signatures And Stationery dialog box.
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You can also specify a theme—a preselected set of fonts, colors, and graphic elements—
to have Outlook create new messages using that theme. For example, if your organization 
uses a specific theme for corporate communications, you can specify that theme as the 
default for outgoing messages as well as for Word documents.

Tip  If you create different types of Office documents (such as Word documents, PowerPoint 
presentations, and corporate e-mail messages) for your organization, you can ensure the 
uniform appearance of all the documents by applying the same theme to all the documents. 
For example, you might choose a theme that incorporates your company’s corporate fonts 
and logo colors.

You can manually format text in the content pane to differentiate it from your default font. 
The local formatting options available in Outlook 2010 are the same as those available in 
Word and other Microsoft Office 2010 programs, and you might already be familiar with 
them from working with those programs. Here’s a quick review of the types of formatting 
changes you can make.

●	 Font, size, and color  More than 220 fonts in a range of sizes and in a virtually 
unlimited selection of colors.

●	 Font style  Regular, bold, italic, or bold italic.

●	 Underline style and color  Plain, multiple, dotted, dashed, wavy, and many 
combinations thereof, in all colors.

●	 Effects  Strikethrough, superscript, subscript, shadow, outline, emboss, engrave, 
small caps, all caps, or hidden.

●	 Character spacing  Scale, spacing, position, and kerning.

●	 Paragraph attributes  Alignment, indentation, and spacing.

●	 Character and paragraph styles  Titles, headings, and purpose-specific font 
formatting (for example, for quotes and book titles).

In a message composition window, the local formatting commands are available both 
from the Message tab and from the Format Text tab. The formatting commands are 
available only when the cursor is in the content pane. When the cursor is in a message 
header box (such as To or Subject), the formatting commands are grayed out.
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You can apply character and paragraph styles from the Quick Styles gallery in the Styles 
group on the Format Text tab, or from the Styles pane that opens when you click the 
Styles dialog box launcher on the Format Text tab.

Styles paneQuick Styles gallery

You can specify the styles that you want to appear in the Quick Styles gallery and in the Styles pane.

Tip  You can preview the effect of a style on the currently selected text by pointing to the 
style in the Quick Styles gallery.

The global formatting options—themes and style sets—are sets of local formatting that 
you can apply with a couple of clicks. 
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A theme applies a preselected combination of colors, fonts, and effects to all the message 
content. You can apply all the elements of a theme to the message content by selecting 
any of the 40 available themes in the Themes gallery, which you open from the Themes 
group of the Options tab.

The Themes gallery.

The default theme for all e-mail messages, Word documents, PowerPoint presentations, 
Microsoft Excel workbooks, and other Office 2010 documents is the Office theme. If 
you don’t apply another theme to your message, the colors, fonts, and effects in your 
message are controlled by the Office theme.
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You can modify the currently applied theme by selecting a color set from the Colors 
gallery, a font set from the Fonts gallery, or an effect from the Effects gallery.

The color set, font set, and effect sets that are the defaults for each theme are named to match 
that theme.

A style set changes the colors, fonts, and paragraph formatting of individual styles. 
You can change the appearance of all the styles in a message by selecting any of the 14  
available style sets (or by creating your own). Selecting a style set changes the appearance 
of all the text in the current document, as well as the appearance of the icons in the 
Quick Styles gallery. You can preview or select a style set by clicking the Change Styles 
button in the Styles group on the Format Text tab, clicking Style Set, and then pointing 
to or clicking a specific style set.
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Choosing a style set.

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window or item window. For information about changing  
the appearance of the ribbon to match our screen images, see “Modifying the Display  
of the Ribbon” at the beginning of this book.

See Also  For more information about Quick Styles, style sets, color schemes, and font 
sets, refer to Microsoft Word 2010 Step by Step by Joyce Cox and Joan Lambert (Microsoft 
Press, 2010).

Adding Signatures to Messages Automatically
When you send an e-mail message to someone, you will most likely “sign” the message 
by typing your name at the end of the message text. You can automatically insert your 
signature text in outgoing messages by creating an e-mail signature and assigning it to 
your e-mail account. Your e-mail signature can include additional information that you 
want to consistently provide to message recipients. 
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Editing your signature.

Your e-mail signature can include any text or graphics you want; you would commonly 
include your name and contact information, but depending on your situation, you might 
also include information such as your company name, job title, a legal disclaimer, a corpo-
rate or personal slogan, a photo, and so on. You can even include your electronic business 
card as part or all of your e-mail signature.

See Also  For more information about electronic business cards, see “Personalizing Electronic 
Business Cards” in Chapter 9, “Work with Your Contact List.”

You can create different signatures for use in different types of messages or for use 
when you’re sending messages from different e-mail accounts. For example, you might 
create a formal business signature for client correspondence, a casual business signature 
for interoffice correspondence, and a personal signature for messages sent from a 
secondary account. Or you might create a signature containing more information to 
send with original e-mail messages, and a signature containing less information to send 
with message replies. You can format the text of your e-mail signature in the same ways 
that you can format message text. If you want to apply formatting that’s not available 
from the selections of buttons across the top of the signature content pane, you can 
create and format your signature either in an e-mail message composition window or 
in a Word document, copy the signature from its original location, and then paste it into 
the signature content pane. Using this technique, you can include artistic content such 
as WordArt and Clip Art in your e-mail signature.



	 Personalizing the Appearance of Message Text    355

Tip  All Office programs share the Microsoft Office Clipboard, so you can easily copy and 
move content between programs. You don’t need to work from the Clipboard to paste the 
most recently cut or copied text into another location; it’s stored in the shared Clipboard, 
so all Office programs have access to it. 

You can assign specific e-mail signatures to specific accounts so that they appear auto-
matically in new messages. You can also manually insert any e-mail signature in any 
message. To manually insert an existing e-mail signature in a message:

	 1.	 Position the cursor where you want to insert the e-mail signature.

	 2.	 On the Insert tab, in the Include group, click the Signature button.

	 3.	 In the Signature list, click the name of the e-mail signature you want to insert.

Tip  If you have not previously set up a signature, clicking the Signature button opens the 
Signatures And Stationery dialog box in which you can create a signature.

To remove an e-mail signature from a message, select and delete the signature content 
as you would any other text.

In this exercise, you’ll first set the default fonts for new messages and for responses. 
Then you’ll create an e-mail signature and instruct Outlook to insert the signature in 
all new messages you create. 

SET UP  You don’t need any practice files to complete this exercise. Display your 
Inbox, and then follow the steps.

	 1.	 Display the Backstage view and then, in the left pane, click Options.

The Outlook Options dialog box opens, displaying the General page.

	 2.	 In the left pane of the Outlook Options dialog box, click Mail.

From the Mail page of the Outlook Options dialog box, you can access other  
dialog boxes that control the settings for specific features.

The Mail page of the Outlook Options dialog box.
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	 3.	 In the Compose messages section, click the Stationery and Fonts button.

The Signatures And Stationery dialog box opens, displaying the Personal 
Stationery page.

The Personal Stationery page.

By default, new messages use the 11-point version of the body font and font color 
specified by the theme (for the default Office theme, this is 11-point black Calibri), 
and responses use the same font, but in blue.

	 4.	 Under New mail messages, click the Font button.

The Font dialog box opens.

	 5.	 Scroll down the Font list, noting the many fonts you can choose from, and click 
Garamond.

The sample text in the Preview pane changes to reflect your selection.
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Choosing a font.

Tip  This Font dialog box doesn’t display font previews in the Font list; you have to 
actually select the font to see what it looks like in the Preview box. You can preview 
fonts in the font lists that are available in a message composition window, either from 
the Basic Text group on the Message tab or from the Font group on the Format Text tab.

	 6.	 Scroll down the Font list and click Lucida Sans.

The sample text changes, as do the options available in the Font Style list. The 
available styles are specific to the fonts installed on your computer.

Tip  Fonts are installed on your computer in the C:\Windows\Fonts folder. You can view 
all the installed fonts in that folder.
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	 7.	 In the Font style box, click Demibold Roman, and in the Size box, click 9.

	 8.	 Click the Font color arrow and then in the palette, click the second darkest square 
in the purple column. (When you point to the square, the ScreenTip identifies it as 
Purple, Accent 4, 25%.)

The Preview box reflects your changes.

Choosing a font color.

	 9.	 In the Font dialog box, click OK.

The New Mail Messages font preview changes to reflect your selections.

	 10.	 In the Replying or forwarding messages area, click the Font button. Repeat 
steps 6 through 9 to set the default font for message responses to Purple, 
9-point, Demibold Roman, Lucida Sans.



	 Personalizing the Appearance of Message Text    359

In this instance, you aren’t differentiating between the color of the font in your 
new messages and message responses; instead you will differentiate by including 
an e-mail signature only in new messages.

Setting identical fonts for new messages and responses.

	 11.	 In the Signatures and Stationery dialog box, click the E-mail Signature tab.

	 12.	 Below the Select signatures to edit box, click New.

Outlook prompts you to first supply a name for the new signature.

Assign a name that will allow you to easily differentiate when inserting signatures.
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	 13.	 In the Type a name for this signature box, enter Casual. Then click OK.

Outlook creates the Casual signature, which is currently blank.

	 14.	 In the Edit signature box, type Thanks! (including the exclamation point), press 
the Enter key, and then type your name.

	 15.	 Select your name. Click the Font arrow and then, in the list, click Lucida 
Handwriting (or any other font you like).

	 16.	 Click the Font Size arrow and then, in the Font Size list, click 14.

	 17.	 Click the Font Color arrow and then, under Standard Colors, click the Purple box. 
Then click away from your name to see the results of your changes.

With the formatting you applied, the name now resembles a signature.

Your signature will appear in e-mail messages exactly as it does here.

	 18.	 Apply any other types of formatting you want; for example, you might want to 
format the Thanks! to match your default message font.

Tip  If you want to include your electronic business card as part of your signature, 
click the Business Card button. Then in the Insert Business Card dialog box, locate 
and click your name, and click OK.

You can manually insert any signature you create in an e-mail message, but it’s a 
more usual practice to instruct Outlook to insert the signature automatically.

	 19.	 In the Choose default signature area, ensure that your default e-mail account is 
shown in the E-mail account box. Then click the New messages arrow and, in 
the list, click Casual.
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Outlook will now insert your signature into all new e-mail messages you send from 
this account but not into replies or forwarded messages.

Tip  If you have more than one e-mail account set up in Outlook, you can instruct 
Outlook to insert a different signature in messages sent from each account. To do so, 
click the account in the E-mail Account list, click the signature you want to use with 
that account in the New Messages and Replies/Forwards lists, and then click OK.

	 20.	 Make any other changes you want, and then click OK in the Signatures and 
Stationery dialog box and in the Outlook Options dialog box.

	 21.	 On the Home tab, in the New group, click the New E-mail button.

A message composition window opens. Your e-mail signature is already present in 
the content pane.

	 22.	 Click to position the cursor in the blank line at the top of the content pane. Then 
type I love this book!

The message text is automatically formatted in the default font you set earlier in 
this exercise.

The inserted Casual signature.

CLEAN UP  Close the message window without saving your changes. Reset the New 
Messages signature to <none> if you don’t want to use the Casual signature you 
created in this exercise.
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Embedding and Modifying Images
E-mail is a means of communicating information to other people, and, as the old saying 
goes, a picture is worth a thousand words. Using Outlook 2010, you can communicate 
visual information in the following ways:

●	 Share photographs with other people by attaching them to or embedding them 
in messages. 

●	 Share information from Web sites, documents, and other visual presentations 
by capturing pictures of things on your screen using a handy tool that is new in 
Office 2010, and then inserting those screen clippings in your message. 

●	 Explain complicated processes and other business information by creating SmartArt 
graphics within messages or by embedding SmartArt graphics that you create in 
other Office 2010 programs. 

●	 Communicate statistical information by creating a chart within a message.

●	 Decorate message content by inserting Clip Art images.

You can insert all these types of images from the Illustrations group on the Insert tab 
into the content pane of an e-mail message, calendar item, or task; or into the Notes 
pane of a contact record. (You can’t insert an image into a note.) 

See Also  For information about SmartArt graphics and charts, see “Creating and Formatting 
Business Graphics” later in this chapter.

Inserting Pictures
The process of embedding a picture in a message or other Outlook item is straightforward. 
Simply follow these steps:

	 1.	 Position the cursor in the content pane or notes pane where you want the picture 
to appear.

	 2.	 On the Insert tab, in the Illustrations group, click the Picture button.

The Insert Picture dialog box opens, displaying the contents of your Pictures library.
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	 3.	 In the Insert Picture dialog box, browse to the folder containing the picture you 
want to insert.

	 4.	 Click the picture to select it, and then click Insert.

Tip  To insert multiple pictures at one time, select the first picture you want to insert. 
Then either press Shift and click the last picture in a consecutive series, or press Ctrl 
and click each individual picture.

After inserting a picture, you can modify the picture and control the flow of text around 
it by using the commands on the Format contextual tab that appears when the picture 
is selected.

Picture formatting options within an Outlook e-mail message.

See Also  For information about applying effects to pictures, see “Modifying Images” later in 
this topic.
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Inserting Clip Art and Shapes
Clip Art is free media—illustrations, photographs, videos, and audio files—that you can 
insert into any Office document. A collection of Clip Art is installed on your computer 
and available whether you are working online or offline. Additional Clip Art is available 
from the Microsoft Office Web site at office.microsoft.com.

After inserting a Clip Art image, you can modify the image and control the flow of text around it.

To locate and insert a Clip Art image, follow these steps:

	 1.	 Position the cursor in the content pane or Notes pane where you want the image 
to appear.

	 2.	 On the Insert tab, in the Illustrations group, click the Clip Art button.

The Clip Art task pane opens on the right side of the Outlook item window.

	 3.	 In the Search box, enter one or more keywords describing the image you want to 
locate.
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	 4.	 In the Results Should Be list, clear the check boxes of any media file types you 
don’t want to search for.

Removing unwanted media types from the search makes it easier to review the results.

	 5.	 Click Go.

	 6.	 Scroll through the search results until you locate the image you want to insert.

Tip  If you don’t find an image that fits your needs, click the Find More At Office.com 
link to display the Images And More page of the Microsoft Office Web site. From that 
page, you can browse categories of images and download images you like to your local 
Clip Art collection.

	 7.	 Point to any image to display a ScreenTip with information about the file; click 
the vertical bar that appears on the right side of the image to display a menu of 
commands.

From the menu, you have several options for working with the selected image.
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You can display more information about each image by clicking Preview/Properties on  
the menu.

	 8.	 On the menu, click Insert.

In addition to Clip Art, you can insert many types of shapes into the content pane of an 
Outlook item. To insert a shape, follow these steps:

	 1.	 On the Insert tab, in the Illustrations group, click the Shapes button.

	 2.	 In the Shapes gallery, click the shape you want to insert.

	 3.	 In the content pane, drag to draw the shape at the size you want.

Available shapes include lines and simple arrows, geometric shapes, common symbols, 
block arrows, mathematical operators, flowchart symbols, stars and banners, and more. 

After inserting a shape, you can change its outline and fill colors and modify its  
appearance in many ways by using the commands available on the Drawing Tools - 
Format contextual tab.
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Capturing Screen Images
The Screenshot and Screen Clipping tools are new features of Outlook 2010 that you can 
use to easily capture images of either an entire window that’s open on your screen or a 
specific area of the screen that you select.

To capture and insert a screen image, follow these steps:

	 1.	 Ensure that the window you want to capture is not minimized or, if you plan to 
capture only a portion of a window, that it’s visible on the screen.

	 2.	 In the Outlook item window, position the cursor in the content pane or Notes 
pane where you want the image to appear.

	 3.	 On the Insert tab, in the Illustrations group, click the Screenshot button.

The Available Windows gallery displays the currently open (non-minimized) 
windows.

You can capture an image of any open window by clicking it in the Available Windows gallery.

	 4.	 To insert an image of an entire open window into the Outlook item, click its icon in 
the Available Windows gallery.
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	 5.	 To capture an image of a portion of the content that’s visible on your screen, click 
Screen Clipping.

If you click Screen Clipping, the active Outlook item is minimized to the Windows 
Taskbar so that the content behind it is visible. White shading covers the desktop, 
and the Screen Clipping tool (which at this point looks like a large plus sign) appears.

Screen Clipping tool

The white shading indicates the portion of the desktop that’s not being captured by the 
Screen Clipping tool.

	 6.	 Position the Screen Clipping tool in the upper-left corner of the area you want 
to capture. Press and hold the mouse button, and then drag to encompass the 
capture area.

The Screen Clipping tool makes a window in the shaded area to indicate the intended 
capture area. You can change the capture area until you release the mouse button.

Tip  You don’t have to be exact with the size of your outline because you can modify the 
screen clipping after you insert it into the Outlook item.
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Screen capture area

The area that will be captured is unshaded and boxed.

	 7.	 When the entire area you want to capture is encompassed in the Screen Clipping 
box, release the mouse button.

The Outlook item is restored from the taskbar and the captured image appears 
in the content pane.

You can format and modify screen clippings in the same ways that you can pictures.
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Modifying Images
Using functionality that is new in Office 2010, you can modify and enhance images 
directly in the item window. From the new Picture Tools contextual tabs that appear 
when you select an image, you can do things like:

●	 Crop or remove background elements from an image.

●	 Sharpen or soften the image content.

●	 Colorize the image and control color saturation and tone.

●	 Apply artistic effects to make an image look as though it’s rendered in pencil, 
chalk, marker, or paint, or has a pattern applied to it.

●	 Add shadows, reflections, and glowing or soft edges.

●	 Apply three-dimensional effects.

Certain effects can be applied to only specific types of files. For example, you can apply 
artistic effects to a photograph that’s saved in .jpg format (a common format for digital 
photos) but not to an illustration that’s saved in .wmf format (a common format for Clip 
Art illustrations).

In this exercise, you’ll insert a photograph in an e-mail message and then use some of 
the new Picture Tools commands to modify the photo before sending it.

SET UP  You need the Lighthouse photograph located in the Chapter10 practice file 
folder to complete this exercise. Open a new message composition window, and 
then follow the steps.

	 1.	 Maximize the message window.

Tip  The graphics in this exercise depict the full-size message window at a width of 
1024 pixels.

	 2.	 On the ribbon, click the Insert tab.

While the cursor is in the To field, only the commands in the Include group are 
available.

	 3.	 Click to position the cursor in the content pane.

The commands in the Tables, Illustrations, Links, Text, and Symbols groups become 
available.
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Commands on the Insert tab are available only when the cursor is located in a text box, such 
as the content pane or notes pane, into which you can insert content.

See Also  For information about inserting and formatting tables, see “Creating and 
Sending Messages” in Chapter 3, “Send and Receive E-Mail Messages.”

	 4.	 On the Insert tab, in the Illustrations group, click the Picture button.

The Insert Picture dialog box opens, displaying the Pictures library or the previous 
location you browsed to in the current computing session.

	 5.	 Navigate to the Chapter10 practice file folder, click the Lighthouse photo, and 
then click Insert.

The photo appears in the e-mail message content pane, and the Picture Tools - 
Format contextual tab becomes active. Because the image is so large, only the 
upper-left corner of the photo is visible in the content pane.

External images are inserted at their original sizes; the dimensions of the selected image are 
shown in the Size group on the Insert tab.
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Troubleshooting  If your screen resolution is set higher than 1024 × 768, you will see 
more of the photo in the message window. Either change the size of your message 
window to match ours or simply follow along with the steps as written and be aware 
that your message window will appear different from those shown here.

	 6.	 On the Format tab, in the Size group, click and hold the down arrow in the Shape 
Height box until the shape height is 4".

The shape’s width decreases proportionally with the shape’s height so that the 
photo maintains its aspect ratio.

You can change the size of a graphic by setting specific dimensions or by dragging its  
resizing handles.

	 7.	 In the Adjust group, click the Remove Background button.

Purple shading obscures all but selected areas of the photo. Resizing handles 
surround an area selector in the center of the photo. The Picture Tools - 
Background Removal contextual tab appears on the ribbon. 



	 Embedding and Modifying Images    373

Resizing handles

The Background Removal tool makes its best attempt at identifying background areas in 
the photo; you can refine the selection to fit your needs.
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	 8.	 Drag the upper-left resizing handle to the left edge of the photo, keeping it just 
above the top of the lighthouse. Then drag the lower-right resizing handle to the 
lower-right corner of the photo.

The purple shading now covers only part of the sky.

Resizing the area selector is one way of controlling the area marked for removal.

	 9.	 On the Background Removal tab, in the Refine group, click the Mark Areas to 
Remove button. Then move the cursor back to the photo.

The cursor shape changes from an arrow to a pencil.

	 10.	 Click the area of sky that remains visible just below the purple screen.

After a moment, a marker appears in the location you clicked, and the purple 
screen extends to cover the area defined by your clicks.

	 11.	 Click two more times (or as necessary) to shade the entire sky. If a click results in an 
unintended effect, click the Undo button on the Quick Access Toolbar to remove 
the effect, and then try again.

Keyboard Shortcuts  Press Ctrl+Z to undo the most recent action. Press Ctrl+Y to repeat 
the most recent action.

See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at 
the end of this book.
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Each click affects the area that resembles the marker location.

Removal markers

Removal markers are labeled with minus signs.

Tip  You can indicate areas of a picture to keep by clicking the Mark Areas To Keep 
button in the Refine group on the Background Removal tab and then clicking the 
picture. Keep markers are labeled with plus signs.

	 12.	 On the Background Removal tab, in the Close group, click the Keep Changes 
button.

The purple-shaded area is removed from the photo, leaving only a white back-
ground. The Background Removal contextual tab disappears from the ribbon 
and the Format contextual tab becomes active again.

	 13.	 Click in the content pane, away from the photo, to see the full effect of removing 
the background from the photo.

The lighthouse and landscape details are clearly outlined as though the photo had 
been carefully trimmed with scissors.
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A three-dimensional effect can be achieved by removing the background from a picture.

	 14.	 Click the photo to select it and activate the Format contextual tab. On the 
Format tab, in the Size group, click the Crop arrow (not the button), and then 
click Aspect Ratio.

A menu of width-to-height ratios opens.

You can crop a graphic to a precise aspect ratio.
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	 15.	 On the Aspect Ratio menu, click 1:1.

A selection area appears on the photo.

	 16.	 Drag the photo to the right within the square selection area so that the left 
edge of the photo is aligned with the left edge of the square.

	 17.	 Press and hold the Shift key, and then drag the lower-right crop handle up and to 
the left until the square selection area encompasses the lighthouse, trees, and only 
a bit of rock. Release the mouse button first, and then the Shift key.

Tip  Holding down the Shift key maintains the aspect ratio while you crop or resize 
a picture.

The resulting selection is approximately three inches square. The area of the 
photo outside of the selection is depicted in grayscale rather than in color.

Crop handles

You can crop a picture to show only the portion you want.

	 18.	 In the Size group, click the Crop button.

The photo is cropped to the square shape.

	 19.	 In the Picture Styles gallery, click the More button.

The Picture Styles gallery expands.
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You can apply predefined sets of formatting to pictures to achieve a professional effect.

	 20.	 In the Picture Styles gallery, point to several of the icons to see their names and 
the effect of applying that style to the selected photo. Then click the Rounded 
Diagonal Corner, White style (in the fourth column of the third row).

A combination of shapes and shadows is applied to the photo.

	 21.	 With the photo still selected, click the Artistic Effects button in the Adjust group.

The Artistic Effects gallery expands.
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You can choose from a wide range of effects.

	 22.	 In the Artistic Effects gallery, point to several of the icons to see their names 
and the effect of applying that style to the selected photo. Then click the Mosaic 
Bubbles effect (in the fourth column of the third row).
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	 23.	 Click in the content pane away from the photo to see the full effect.

The artistic effect causes the photo to more closely resemble a painting than a 
photograph.

An artistic effect.

	 24.	 In the message header, enter your e-mail address in the To box and enter SBS 
Picture Tools in the Subject box. Then send the message.

	 25.	 When the message arrives in your Inbox, note that you can select and copy the 
embedded picture in the Reading Pane or in the open message window for use in 
other documents.

CLEAN UP  Close any open message windows. Move the SBS Picture Tools message to 
the SBS Messages folder and retain it for use in later exercises. 

Tip  When you respond to a message that contains an embedded image, clicking the image 
activates the Picture Tools Format tab that contains a restricted range of formatting options. 
(Fewer formatting options are available when you work with the modified image than were 
available in the original message window.)
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Creating and Formatting Business Graphics
Images can be especially valuable in business communications, when you need to clearly 
explain facts or concepts, particularly to a global audience. In Outlook 2010 (and other 
Office 2010 programs), you can depict relationships, processes, cycles, hierarchies, and 
so on, by creating SmartArt graphics, and you can depict graphical representations of 
data by creating charts.

You can create a SmartArt graphic directly in an e-mail message or you can convert an 
existing list into a SmartArt graphic. When sending a message, Outlook converts any 
SmartArt graphics within the message to static graphics.

You can create a chart directly in an e-mail message. Charts you create in an Outlook 
message look exactly like those you would create in an Excel workbook—because they 
are based on an Excel data source that is created from within Outlook.

To create a chart in a message or other Outlook item, follow these steps:

	 1.	 Position the cursor in the pane where you want the picture to appear.

	 2.	 On the Insert tab, in the Illustrations group, click the Insert Chart button.

The Insert Chart dialog box opens.

You can filter the available chart types by choosing a category from the left pane.
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	 3.	 In the Insert Chart dialog box, locate the type of chart you want to create. Click the 
chart icon, and then click OK.

A basic chart appears in the Outlook item, and several Chart Tools contextual tabs 
become active on the ribbon. An Excel program window opens, containing the 
mock data from which the basic chart is built.

Changes you make to the data are immediately reflected in the chart.

	 4.	 Update the mock data with your own. When you finish, close the Excel window. 

It’s not necessary to save or name the worksheet that contains the data depicted 
by the chart.

When you want to send a chart depicting important data, it’s safer to store the data in 
an Excel worksheet, create a chart in the Excel workbook from the data, and then embed 
that chart in an e-mail message.

In this exercise, you’ll create a SmartArt flowchart in an e-mail message. 

SET UP  You don’t need any practice files to complete this exercise. Open a new 
message composition window, and then follow the steps.

	 1.	 Maximize the message window, and then click in the content pane.
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	 2.	 On the Insert tab, in the Illustrations group, click the SmartArt button.

The Choose A SmartArt Graphic dialog box opens.

You can filter the contents of the dialog box by clicking the categories in the left pane.

	 3.	 Scroll through the center pane of the dialog box for an overview of the available 
SmartArt graphics. 

Tip  You can display the name of a SmartArt graphic by pointing to it.

	 4.	 In the left pane, click Process. Scroll to the top of the center pane and click the 
second icon in the second row (Alternating Flow). 

This is a process diagram showing the details of a three-step process.

A preview and description of the selected SmartArt graphic appear in the right pane.
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	 5.	 In the Choose a Smart Art Graphic dialog box, click OK.

Outlook inserts a basic version of the selected process diagram in the content 
pane. It looks similar to the preview graphic, but without the colors and three-
dimensional aspects. (You select formatting options later.) The Text pane opens and 
the two SmartArt Tools contextual tabs, Design and Format, appear on the ribbon. 

In the Text pane to the right of the graphic, you can build a hierarchical list that transfers 
content to the graphic.

Tip  You can display or hide the Text pane for any SmartArt graphic by clicking 
the diagram and then clicking the Text Pane button in the Create Graphic group 
on the Design contextual tab. Or you can click the Text Pane tab on the left side of  
the diagram drawing area.

You can enter text in the Text pane or directly in the graphic—selecting a graphic 
element or positioning the insertion point within the bulleted list also selects the 
corresponding element in the graphic or Text pane. The graphic name is shown 
at the bottom of the Text pane; pointing to it displays a ScreenTip describing the 
purpose of the current type of graphic.

	 6.	 In the Text pane, click the [Text] placeholder to the right of the first bullet, and 
then type Plan.

As you type in the pane, the text appears in the diagram.
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	 7.	 Click the [Text] placeholder to the right of the first second-level (indented) bullet, 
and type Survey current customers. Press the Down Arrow key to move to the 
next second-level bullet, and then type Survey potential customers.

The font size in the graphic adjusts to fit the text into the available space.

	 8.	 Press Enter to create another second-level bullet in the Text pane and in the 
graphic, and then type Analyze competition.

	 9.	 In the diagram, click the second solid blue box to select the placeholder, and then 
type Define.

As you type, the text also appears in the second first-level bullet in the Text pane.

	 10.	 In the third solid blue box, type Design.

	 11.	 On the Design contextual tab, in the Create Graphic group, click the Add Shape 
arrow (not the button) and then, in the list, click Add Shape After.

An additional item appears at the right end of the diagram and in the Text pane. 

You can add shapes above, below, before, or after the selected shape, depending 
on the diagram layout.

	 12.	 In the new solid blue box, type Develop.

	 13.	 In the Text pane, click at the end of the word Develop, and then press Enter.

A first-level bullet and additional shape appear.

You can easily add to the structure of a SmartArt graphic.

	 14.	 Type Test and then, in the Text pane, click the Close button.

At its current size, the text within the diagram is very difficult to read.

	 15.	 Point to the move handle (the vertical line of four dots) on the right side of the 
diagram. When the pointer becomes a double-headed arrow, drag the move 
handle to the right so that the diagram fills the width of the message window.

	 16.	 In the Layouts gallery, click the More button. 
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The Layouts gallery expands.

The Layouts gallery.

	 17.	 In the Layouts gallery, point to a few of the icons to preview the effect of the SmartArt 
graphic layout on your content. Then click the second layout in the second row 
(Continuous Block Process).

The process diagram layout changes, as do the styles available on the Design tab.

The content is reconfigured to fit the new layout.

	 18.	 In the SmartArt Styles gallery, click the More button. 

The SmartArt Styles gallery expands.
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The SmartArt Styles gallery.

	 19.	 In the SmartArt Styles gallery, point to a few of the icons to preview the effect of 
the style on your graphic. Then in the 3-D section, click the first icon (Polished).

	 20.	 In the SmartArt Styles group, click the Change Colors button.

The Change Colors gallery expands.

The colors shown in the gallery change to match the colors specified by the active theme.

The color schemes displayed in the Change Colors gallery are variations of the current 
theme colors, and they are organized in groups that reflect the six thematic accent 
colors. Changing the theme also changes the color schemes in the gallery.
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	 21.	 In the Change Colors gallery, point to a few of the icons to preview the effect 
of the color scheme on your graphic. Then under Colorful, click the second icon 
(Colorful Range – Accent Colors 2 to 3).

The color scheme of the graphic changes to match your selection.

	 22.	 In the message header, enter your e-mail address in the To box, and enter SBS 
Development Cycle in the Subject box. Then send the message.

When you receive the message, the SmartArt graphic is visible in the Reading 
Pane. Regardless of the size at which you created the graphic, the entire graphic 
is visible in the Reading Pane.

	 23.	 Open the message, and click the SmartArt graphic.

The SmartArt graphic has been converted to a static image. If you open the message 
from your Sent Items folder, you’ll find that the same is true of the graphic in that 
message.

The graphic resizes with the message window.

CLEAN UP  Close the message window. Move the SBS Development Cycle message to 
the SBS Messages folder, and retain it for use in later exercises.
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Changing Message Settings and Delivery Options
When you send a message, you can include visual indicators of the importance, sensitivity, 
or subject category of a message or other Outlook item, flag a message for follow-up, 
restrict other people from changing or forwarding message content, provide a simple 
feedback mechanism in the form of voting buttons, and specify message delivery  
options to fit your needs.

Message settings and delivery options

In the received message, tags are displayed as text in the message header.

Common message settings and delivery options include:

●	 Flags and reminders  You can place an outgoing message on your task list, add an 
informational reminder to it, or set a reminder to appear at a certain time and date, 
for yourself and for message recipients.

●	 Importance  You can indicate the urgency of a message by setting its importance 
to High or Low. A corresponding banner appears in the message header and, if the 
Importance field is included in the view, an importance icon appears in the Inbox 
or other message folder.

●	 Sensitivity  You can indicate that a message should be kept private by setting 
its sensitivity to Confidential, Personal, or Private. No indicator appears in the 
message folder, but a banner appears in the message header to indicate a sen-
sitivity level other than Normal. You can choose to include the sensitivity as one 
of the message attributes shown in the Inbox pane, but if you do, it replaces the 
message subject, which isn’t very helpful.

●	 Security  If you have a digital ID, you can digitally sign the message; or you can 
encrypt the contents of the message.
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●	 Voting options  If you and your message recipients have Microsoft Exchange Server 
accounts, you can add voting buttons to your messages to enable recipients to 
quickly select from multiple-choice response options.

●	 Tracking options  You can track messages by requesting delivery receipts and read 
receipts. These receipts are messages automatically generated by the recipient’s 
e-mail server when it delivers the message to the recipient and when the recipient 
opens the message.

●	 Delivery options  You can have reply messages delivered to an e-mail address 
other than yours, specify a date and time for the message to be delivered and to 
expire, and set advanced attachment format and encoding options.

●	 Categories  You can assign a message to a color category that will be visible to the 
recipient if he or she views the message in Outlook.

Tip  You can easily sort and group messages by message settings by choosing the message 
setting in the Arrange By list.

The most commonly used options are available in the Tags group on the Message tab 
of the message window. You can access other options from the Properties dialog box, 
which you open by clicking the Tags dialog box launcher.

The Properties dialog box.
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You can limit the actions other people can take with messages they receive from you 
by restricting the message permissions. For example, you can prevent recipients from 
forwarding or printing the message, copying the message content, or changing the 
content when they forward or reply to the message. (Restrictions apply also to mes-
sage attachments.) Within a message window, permission options are available both 
on the File tab and in the Permission group on the Options tab.

See Also  For information about digital signatures and for more information about restricting 
recipients from forwarding, copying, or printing messages you send, see “Securing Your 
E-Mail” in Chapter 11, “Manage E-Mail Settings.”

Key Points
●	 You can format the text and background of your messages, either by choosing 

individual formatting options and styles or by applying a theme.

●	 You can automatically insert contact information in e-mail messages by using an 
electronic signature. You can create different signatures for different purposes 
and instruct Outlook to insert a specific signature for each e-mail account and 
message type.

●	 You can insert many types of images including photos, screen clippings, and Clip 
Art into an Outlook item and modify the appearance of the inserted image by 
using commands available from the Picture Tools contextual tab.

●	 You can create graphical representations of processes, hierarchies, and other 
organizational structures by using the SmartArt feature.

●	 You can create a chart directly in an Outlook item as a graphical representation 
of data stored in an associated Excel worksheet.

●	 You can make outgoing messages more useful by setting their properties to com-
municate information to the message recipient and by setting delivery options so 
you are informed when the message is received and read.
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